
 
 

 
 
   

 
 
 
 
 
 
 

 

Advanced Workflow Automation Manager 
 

User Guide 
Version 12, Created May 18, 2018 
 

 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 



  AWAM™ 

About This Guide  User Guide 

Page 2 of 105  ©2018 Window Book, Inc.  All Rights Reserved. 

 

ABOUT THIS GUIDE 

The instructions and descriptions contained in this document were accurate at the time of publishing; 
however, succeeding products and documents are subject to change without notice.  Therefore, 
Window Book, Inc. assumes no liability for damages incurred directly or indirectly from errors, 
omissions, or discrepancies between the product and this document.   
 
Go to www.windowbook.com to download the most current version of this document.   
 
This document is formatted for 2-sided printing. 
 
Advanced Workflow Automation Manager™, AWAM™, DAT-MAIL™, eDM10X™, and MailDrop Engine™ 
are trademarks of Window Book, Inc. 
The following are trademarks (indicated by ™) or registered trademarks (indicated by ®) are owned by 
the United States Postal Service:  USPS® and PostalOne!®. 
Mail.dat® is a registered trademark of the International Digital Enterprise Alliance, Inc. (IDEAlliance). 
Windows® is a registered trademark of Microsoft Corporation in the United States and/or other 
countries. 
All other product names are trademarks, registered trademarks, or service marks of their respective 
owners. 
 
Copyright © 2018 Window Book, Inc.  All rights reserved.  All intellectual property rights remain the 
property of Window Book, Inc.  No part of this publication may be reproduced, distributed, modified, 
displayed, transmitted, stored in a retrieval system, or translated into any human or computer language, 
in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, 
without the prior written permission of the copyright owner, Window Book, Inc., 300 Franklin Street, 
Cambridge, MA 02139. 

CONTACT INFORMATION 

  WINDOW BOOK, INC. 
 300 Franklin Street 
 Cambridge, MA  02139 
 
  Corporate: 617-395-4500 
 Client Services: 800-524-0380 
  sales@windowbook.com 
 Support: 800-477-3602 
  techsupport@windowbook.com 
 Fax: 617-395-5900 
 On the Web: www.windowbook.com 
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REVISION HISTORY 

This section contains a list of any significant changes that were made from the previously published 
version of this Guide, including a brief description of the change, the type of change made (i.e. Revision, 
New, or Deletion), a link to the location in the Guide where the change occurred, and any pertinent 
details relating to the change. 
 

CHANGE TYPE LOCATION IN GUIDE DETAIL 

Updated cover page Revision Document cover page 
Updated cover page design and 
added new Window Book logo. 

Updated section Revision ABOUT THIS GUIDE 

Included “MailDrop Engine” in the 
trademark information and 
updated the copyright information 
for 2018. 

Added section New 
USING THE ‘INTELLIGENT 
MAIL BARCODE’ TAB 

Added information on the new 
‘Intelligent Mail Barcode’ tab 
introduced in DATMAIL version 
20.18.04.18. 

Updated section Revision IMPORT PROFILES 

Added a bulleted item to the list of 
what can be accomplished by an 
Import Profile to include controlling 
the IM Barcode assignment 
options. 

Updated section Revision 
CREATING & USING AN 
IMPORT PROFILE 

Updated the procedure for creating 
an Import profile to include the 
‘Intelligent Mail Barcode’ tab. 

Updated section Revision 
CREATING A MERGE 
PROFILE 

Updated the procedure for creating 
an Merge profile to include the 
‘Intelligent Mail Barcode’ tab. 

Updated section Revision 
CREATING A POST 
PROCESS PROFILE 

Updated the procedure for creating 
a Post Process profile to include the 
‘Intelligent Mail Barcode’ tab. 

Updated section Revision 
AWAM Post-Import 
Process Mail.dat Files 
Utility 

Updated the screen image and 
added information about the filter 
function now available on the Jobs 
browse.  Included a link to a how-to 
video. 
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CHANGE TYPE LOCATION IN GUIDE DETAIL 

Updated section Revision 
AWAM Processing Log 
View 

Updated screen images and added 
information about the View Detail 
button on the AWAM Log View 
screen. 

Added section New 
Turn Off Logging 
Barcodes 

Added an example import profile 
that uses the new ‘Intelligent Mail 
Barcode’ tab. 

Added section New 
Log Barcodes Without 
Overwriting Them 

Added an example import profile 
that uses the new ‘Intelligent Mail 
Barcode’ tab. 

Added section New 

Turn On Overwrite for 
Trays/Pallets, 
Generate/Replace 
Barcodes 

Added an example import profile 
that uses the new ‘Intelligent Mail 
Barcode’ tab. 

Updated sections Revision 
Throughout the 
document 

Updated screen images to coincide 
with current version. 
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BEFORE YOU BEGIN 

SYMBOLS YOU SHOULD KNOW 

The following symbols appear throughout this document: 
 

 Where displayed, this Information icon denotes important information regarding the subject 
matter at hand.  The information is intended to provide helpful hints, references to other 
locations in the document to help further understanding about the current subject-matter, 
and/or include special requirements pertaining to specific subject-matter.  It is important that 
the information provided be read and thoroughly understood before proceeding. 

 

 Where displayed, this Attention icon is intended to make the reader take special notice as the 
information provided is critical in nature to the subject matter at hand.  It is not intended to 
lessen the importance of the information provided with the Information icon noted above; but 
to bring additional attention in situations of extreme necessity. 

 

 Where displayed, this Troubleshooting icon denotes helpful hints and tips for the subject matter 
at hand.  The information in the troubleshooting tip is intended to provide helpful hints and 
resolutions for some of the more common issues that can occur during operation. 

PURPOSE 

The purpose of this Guide is to provide description and use information for AWAM. 
 
Information pertaining to the activation and registration of AWAM, along with installing the service, 
setup instructions, and information on updating the software is provided in the “AWAM Setup Guide”, 
which is available on Window Book’s web site at:  https://www.windowbook.com/Support/UserGuides.  
Registration and/or login is required. 
 
 
 
 
 
 

https://www.windowbook.com/Support/UserGuides
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INTRODUCTION 

Window Book’s Advanced Workflow Automation Manager™ (AWAM) is a powerful automated 
processing tool that uses profiles created by the Mailer to:  1) Import Mail.dat® files into DAT-MAIL, 
while performing a large variety of automated tasks on each file before and after the import occurs; and 
2) Merge and/or apply automated updates or changes to files that are already in DAT-MAIL™ (i.e. post-
import).   
 
While all profiles are created within AWAM™, they are applied using different utilities.  Import profiles 
are used by AWAM and the AWAM File Manager.  Merge and Post Process profiles are used by the 
AWAM Processing utilities available from within DAT-MAIL. 
 
Functioning as a true Windows® service, AWAM is intended to run on a server, but can also be run on a 
computer operating in a stand-alone or single installation environment.  In a server with workstation(s) 
environment, the available functionality differs slightly between the server and workstation; both of 
which are documented in this Guide. 
 
AWAM can process up to 20 Mail.dat files simultaneously for much faster throughput (depending on the 
number of CPUs and memory available on the server; as well as, the size of the Mail.dat files being 
processed).  AWAM activity and profiles are managed via the AWAM Control Center, which is accessible 
from both the server and any workstations where DAT-MAIL and AWAM are installed.  Full control of 
the AWAM service is only available on the server installation of AWAM (i.e. install, uninstall, start, and 
stop); however, users are able to pause/resume and restart the service from a workstation installation, 
if necessary. 
 
AWAM also includes a separate utility to be used on workstations called the AWAM File Manager (File 
Manager).  The File Manager works specifically with Import profiles and provides the ability for a user to 
manually select and stage the Mail.dat files to be imported into DAT-MAIL, or use the AWAM Rules 
Manager to automatically do so by applying user-defined rules to each file.  For more information about 
the AWAM File Manager, refer to the “AWAM File Manager Installation & User Guide, which is available 
on Window Book’s web site at:  https://www.windowbook.com/Support/UserGuides.  Registration 
and/or login is required. 
 
The AWAM Processing utilities that are used for merging files and/or applying post-import 
updates/changes are available for use from within DAT-MAIL; therefore, any computer where DAT-MAIL 
is installed with AWAM can use these utilities (i.e. server, stand-alone/single-installation computer, and 
workstations). 
 
 
 
 
 
 
 
 

https://www.windowbook.com/Support/UserGuides


AWAM™ 

User Guide  Before You Begin 

©2018 Window Book, Inc.  All Rights Reserved.  Page 9 of 105 

REQUIREMENTS 

The requirements to be able to use AWAM™ as documented in this Guide are as follows: 

• DAT-MAIL software version 20.18.04.18 (or newer) must be installed on the server and then any 
workstations in order for workstations (if applicable) to have access to the functionality 
documented in this Guide. 

• Clients must have DAT-MAIL Toolbox to be able to activate and use the Planalyzer option 
available in the AWAM profiles; 

• Clients must have the Editor with the Palletization add-on or the Toolbox to activate and use the 
Palletization option available in the AWAM profiles; 

• AWAM Import profiles must use UNC path names (refer to the CREATING & USING AN IMPORT 
PROFILE section in this Guide, specifically step 6, for more information) in a server with 
workstation(s) environment; 

 Mapped drives cannot be used with AWAM. 

 Additional requirements exist for activating and registering AWAM.  These requirements are 
detailed in the “AWAM Setup Guide”, which is available on Window Book’s web site at:  
https://www.windowbook.com/Support/UserGuides.  Registration and/or Login is required. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.windowbook.com/Support/UserGuides
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COMPONENT DESCRIPTION & USE 

AWAM can be used in a server with workstation(s) environment or in a stand-alone/single-installation 
environment.  If it is being used in a server with workstation(s) environment, the accessibility of some 
functions located in the AWAM Control Center differs slightly between the server and workstation(s).  
These differences are noted where applicable, throughout this document. 
 
This section discusses AWAM in its entirety, i.e. component identification and description, and how 
AWAM works. 

AWAM CONTROL CENTER - INTRODUCTION 

The AWAM Control Center (Control Center) is accessible from the server (or computer in a stand-alone 
environment) and any workstation(s) where DAT-MAIL and AWAM are installed and registered.  The 
functionality that is accessible from the Control Center differs slightly between a server and a 
workstation.   
 

Function Server Workstation 

Monitor what is currently being processed through AWAM X X 

View processing history X X 

View the various logs for each Mail.dat that was imported, merged, 
or had post-processing applied to it for troubleshooting purposes 

X X 

View the PDFs generated during an import when the Batch Reports 
function is set up to do so as part of the import profile used 

X X 

Manage the AWAM Windows® service and logon information for 
running it 

X  

Control the maximum number of profiles that can run 
simultaneously 

X  

Control how often the service checks the appropriate import 
folder(s) for incoming Mail.dat files 

X  

Control the communication port AWAM uses X  

Purge CMD files to maximize disk space and system performance X  

Manage AWAM notifications X  

Export and Import AWAM profiles X X 

Stop and start the service X  
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Function Server Workstation 

Pause the service X X 

Restart the service  X 

Minimize the AWAM Control Center X X 

Access the Browse Profiles screen where profiles are managed; as 
well as, activated and deactivated 

X X 

 
The AWAM Control Center is a separate executable; therefore, the DAT-MAIL program can be closed 
with the Control Center remaining open and functioning. 

Launching the AWAM Control Center 

To launch AWAM’s Control Center, perform the following from within DAT-MAIL: 

• Launch DAT-MAIL; and 

• From DAT-MAIL’s main screen, click the AWAM icon.  The AWAM Control Center will 
open/display. 

 
AWAM Enabled 
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AWAM Control Center – In Detail 

The AWAM Control Center is comprised of the following: 
 

 
 

 Unless otherwise stated, it is assumed that the features or functioned documented in this section 
are available in both server and workstation installations of the AWAM Control Center. 

• File menu .  From the file menu the user can select one of four options: ‘Setup’ (servers 
only); ‘Export Profiles’; ‘Import Profiles’; or ‘Exit’.   

 
 

 The Fie menu in the Control Center on a workstation would not include the ‘Setup’ menu option.  
The File menu on a workstation installation of AWAM would appear as follows: 

 
AWAM Control Center On A Workstation 
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 Setup Menu:  This menu option is only available on server or stand-alone installations.  It is 
not displayed/accessible on workstation installations of AWAM. 

Selecting this menu option displays the DAT-MAIL AWAM Setup window.  Within this 
window are two control buttons used for 
installing and removing the AWAM Windows® 
service (refer to the AWAM Setup Guide for more 
information on installing the service).  There are 
also three tabs in this window: General; 
Maintenance; and Notifications: 
 
o General Tab:  From within this tab, the user 

can specify the maximum number of profiles 
that can run simultaneously, how often the 
service checks the appropriate import 
folder(s) for incoming Mail.dat files, and 
control what communication port the service 
uses;  

 
o Maintenance Tab:  From within this tab is the ability to manage the number of CMD 

files stored in the Processed and Failed 
folders (i.e. 
‘\\...\wb\MDV\data\AWAMCMDFiles’) to 
help with the maintenance of disk space on 
the server; as well as, machine performance.  
Auto-deletion of these CMD files occurs daily 
by the system and any time the AWAM 
service is started.  Files that are older than 
the specified date are deleted.  10 days is the 
default setting.  To purge all of the CMD files 
located in these two folders (including ones 
newer then the specified date), click the 
Delete Processed CMD Files button.   

To also help maintain disk space, users can also set up AWAM to automatically delete 
the Log Records created during processing that are older than a specified number of 
days (default is 7 days).  
 

https://www.windowbook.com/Support/UserGuides
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o Notifications Tab:  From this tab, users can 

activate e-mail notifications for both 
successful completions of AWAM processes; 
as well as, failed attempts.  Simply select 
(check) the corresponding check-box 
(Success and/or Failure) and enter the 
recipient’s e-mail address.  Multiple e-mail 
addresses can be entered by separating the 
addresses with a semi-colon.   

 
 

 Depending upon the number of AWAM processes that run each day, the number of e-mails 
received if ‘Notify on Success’ is enabled could be overwhelming for the recipient(s). 

 To ensure delivery of system-generated notifications, it is important for Clients to white-list the 
pertinent Window Book send-from e-mail addresses on their server(s).  A list of these e-mail 
addresses can be found on the Window Book web site at:  
https://www.windowbook.com/home/White-List-Help. 

The subject line of the Successful e-mail will provide the Job ID, Job No., the Status of 
the AWAM process, and the name of the server the process was run on.   

 
The body of the e-mails will provide what type of process was run (i.e. import, merge, 
post-import), what profile was used for the process, a date/time stamp, the Job ID (in 
the event of a merge, the job ID of the newly created Mail.dat is provided), the Job No., 
the Job Description (i.e. Job Name), and the name of the Mail.dat file name that was 
imported. 

 

 

https://www.windowbook.com/home/White-List-Help
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The Failed e-mail notification will provide a status notification in the Subject line and the 
associated server name.  The e-mail will also contain information about the error(s) that 
caused it to abort and where the associated file is located on the server (or computer in 
a single-installation or stand-alone environment). 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



AWAM™ 

User Guide  Component Description & Use 

©2018 Window Book, Inc.  All Rights Reserved.  Page 17 of 105 

 

• File menu .  From the file menu the user can select one of four options: ‘Setup’ (servers only); 
‘Export Profiles’; ‘Import Profiles’; or ‘Exit’.   

 

 Export Profiles:  This option allows Mailers to export their existing profiles into a single, 
zipped file, for backup purposes (refer to the EXPORTING PROFILES section in this Guide for 
more information); 

 Import Profiles:  This option allows Mailers to import previously exported profiles into 
AWAM (refer to the IMPORTING PROFILES section in this Guide for more information).   

 Exit:  This option in the AWAM Control Center’s File menu shuts down the Control Center 
and unloads it from memory (refer to the Minimizing Versus Exiting the Control Center 
section in this Guide for more information). 

• Help menu .  The functionality accessible via the Help menu differs between server and 
workstation installations of AWAM.   

 Server/Standalone:  The customer information entered at the time of registration can be 
viewed along with the product registration key.  In addition, the existing product registration 
key can be updated if necessary; and 

 
 



  AWAM™ 

Component Description & Use  User Guide 
 

Page 18 of 105  ©2018 Window Book, Inc.  All Rights Reserved. 

 

 Workstation:  The customer information entered at the time of registration can be viewed 
along with the product registration key.  The existing product registration key cannot be 
updated; however. 

 
 
 

 
 

Activity tab  .  The Activity tab displays all of the current processing activity that has occurred 
while the Control Center has been open.  It provides the File Name, Job ID, Status, Hist. Job ID, 
Progress, Profile Name, Profile Type, Started Date and Time, Completed Date and Time, and the 
Import Path being used in columnar format.  This same activity is also displayed in the History tab 

(refer to ‘History tab ’ for more information).   
 
If the AWAM Control Center is closed (not minimized), all of the reported processing activity will 
be removed.  When the AWAM Control Center is re-launched, the panel in the Activity tab will be 
blank or empty.  The processing activity that had been displayed is still accessible via the History 

tab , however. 
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The information contained in each columns can be sorted in ascending or descending order by 
clicking the column heading.  To sort multiple columns, press and hold the ‘CTRL’ key on the 
server or computer’s keyboard while clicking the column headings.  When column headers are 
clicked for sorting purposes, a number will display, in brackets, to identify the selected sort order 
(e.g. in the image below, Status Display Panel is set up to sort any reported data by ‘Status’, and 
then ‘Job ID’).  Click the column heading multiple times to increase or decrease the sort order of 
the selected column. 
 

 
 

The possible ‘Status’ values that will display are: 

 Waiting:  Jobs that have been picked up by AWAM and are waiting for AWAM to begin 
processing them; 

 In Progress:  There are varying degrees of a submission being ‘In Progress’ that are displayed 
as percentages.  The percentage number displayed updates as the process moves to 
completion.  In addition, jobs that register as locked in the ‘Progress’ field also display a 
Status of ‘In Progress’.  If a job is registered as ‘locked’ it means AWAM is unable to proceed 
with the process and it wait an allotted time (several minutes).  During that time, if the job 
becomes unlocked, AWAM will proceed with the submission.  If the job does not become 
unlocked during that allotted time, AWAM will time out; 

 Aborted:  Submissions will show a status of Aborted for a couple of reasons; one of which is, 
when AWAM times out while a job is locked.  The other is when the system crashes while 
the service is stopped, orphaning some submissions that were in the “Waiting” or “In 
Progress” Status.  After such an event occurs, re-starting the service will cause the Status of 
these orphaned submissions to change to ‘Aborted’, a good notification for the user that 
those particular jobs need special attention (refer to the AWAM Processing Log View section 
in this Guide for more information about Aborted submissions); and 

 Completed:  The applied AWAM process has completed and is finished successfully. 
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• History tab .  The History tab contains a running history of all of the processing activity that 
has occurred.  Unlike the data stored in the Activity tab, this history is never lost or removed if 
the AWAM Control Center is closed and then relaunched. 

The data reported in the History tab can be filtered for easier reference, by selecting a filter 
option from the drop down provided. 
 

 
 
If the filter option ‘Custom Range’ is selected, a date range can be entered. 
 

 
 

• START/STOP & RESTART buttons .  The START/STOP button is only enabled/displayed in 
server or standalone installations of AWAM.  The RESTART button is only enabled/displayed on 
workstation installations of AWAM. 

o START:  The START button starts the AWAM service.  When the START button is 
displayed, a corresponding line of text describing the current state of the service will 
display to the right of the button (i.e. “Service is STOPPED”); 
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o STOP:  The STOP button stops the AWAM service.  This function can only be performed 
from AWAM on the server (or computer in a stand-alone environment).  When the STOP 
button is displayed, a corresponding line of text describing the current state of the 
service will display to the right of the button (i.e. “Service is RUNNING”); and 

 
 

 Do NOT use the Task Manager on the computer or server to stop the AWAM service! 

 If the Windows® service is not installed, the ‘STOP/START’ button will be grayed out (not enabled) 
and a message of “Service is NOT Installed” will display.  Install the AWAM Windows® service to 
activate the ‘STOP/START’ button (refer to the “AWAM Setup Guide” for more information). 

 
 

o RESTART:  The RESTART button restarts the AWAM service.  This is an ease-of-use 
function for workstation users if the AWAM service has been stopped on the server.  
This function can only be performed from AWAM on a workstation.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.windowbook.com/Support/UserGuides
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• Pause/Resume button .  The Pause/Resume button is available in both server and 
workstation installations of AWAM.  It allows the user to pause the AWAM service.   

 

 
 

 
 

 Backup systems are able to stop AWAM (and restart it) so that the backup procedures don’t 
interfere with AWAM processes that could be running.  The backup program can drop a file 
named “PauseAWAM.txt” into the DAT-MAIL Data directory.  When AWAM sees this file, it will 
finish processing the files in the input folders up until the time the text file was dropped 
in.  AWAM will then remove the “PauseAWAM.txt” and replace it with a new file named 
“AWAMPaused.txt”.  The presence of this file will trigger the backup program that it is ok to 
proceed with backups.  When the backups are finished, the backup program should remove 
“AWAMPaused.txt” from the directory so that AWAM can begin processing files again.  When 
this feature is used, a message will appear on the Advanced Navigator View and the AWAM 
Control Center stating that the Service is paused.  This action will also be written to the AWAM 
log file.  
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• Edit Profiles button .  Clicking this button displays the Browse Profiles screen, from which 
the user can create new profiles; as well as, manage existing profiles (refer to the Browse 
Profiles Screen section below for more information).   

• Minimize button .  Clicking this button closes the AWAM Control Center, leaving a product 
icon to display in the server’s System Tray.  For more information about Control Center and 
processing capabilities using the Minimize control, refer to the Minimizing Versus Exiting the 
Control Center below). 

• Profile Status Line .  The current number of active profiles are displayed on this status line. 

 

EXPORTING PROFILES 

The ‘Export Profiles’ menu option, available on both servers and workstations, allows Mailers to export 
their existing profiles into a single, zipped file, for backup purposes.   
 
To export profiles, do the following: 
 
 

1. In the AWAM Control Center, select the ‘File’ 
menu and ‘Export Profiles’; 
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2. The Select profiles for export 
screen will display.  The default 
path/location where the exported 
file will be saved to is 
displayed/used.  The default path 
is derived from the setting 
specified for the 
‘\\...WB\MDV\Data’ folder when 
DAT-MAIL was installed and is 
currently using.  This can be 
changed by clicking the Export 
path button if desired; 

 
 

 If the destination folder where profiles are to be exported to is located on a server different then 
the one DAT-MAIL/AWAM is currently installed on, a UNC path name must be used (see image 
above). 

 
 
 

3. Individual or all of the existing profiles can 
be exported.  To select individual profiles, 
select the profile in the list and click the 
Select button.  To select all of the profiles, 
simply click the Select All button.  Once 
the desired profiles are selected (if a 

profile is selected, a green check-mark  
will display next to it in the list), click the 
Export button. 
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4. When the export is complete, a confirmation dialog will display that contains the file name 
and where it was exported to.  In addition, the exported file name is copied to the computer 
or server’s clipboard, allowing the user to easily search for the file by being able to paste it 
into Windows® Explorer.  Click the OK button to close the dialog. 

 
 

 It is important note that some information that is or can be stored in profiles is specific to the 
current DAT-MAIL/AWAM installation and may need to be adjusted if and when the same profiles 
are imported back into AWAM. 

 

IMPORTING PROFILES 

The ‘Import Profiles’ button allows Mailers to import previously exported profiles into AWAM.   
To import profiles, do the following: 
 

1. In the AWAM Control Center, select the ‘File’ menu and ‘Import Profiles’; 

 
 

2. The Select files to import screen will display.  To import profiles, click the File for Import 
button; 
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3. A Windows® Explorer screen will open and display the default export location, which is  

‘\\...WB\MDV\Data’.  Any AWAM exported profile .zip files will display.  If the exported 
profile file was saved to a different location, browse to that specific location.  Select the file 
to import and click the Open button; 

 
 

4. The Select profiles for import screen will display.  All of the profiles taken from the exported 
file will display and will be selected for importing.  Individual profiles can be deselected so 
they are not imported by selecting them and clicking the Unselect button.  When ready, 
click the Import button.  All the selected profiles will be imported back into AWAM; 

 
 

5. A dialog will display confirming the number of profiles that were imported.  Click the OK 
button to close the dialog; 
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6. In the AWAM Control Center, click the Edit Profiles button; 

 
 
 

7. The Browse Profiles screen will display.  All of the existing profiles will be listed, along with 
all of the newly imported profiles.  Newly imported profiles will not be active and their 
profile names will contain the word IMPORTED, along with a date and time stamp.  This 
avoids the potential of having duplicate profile names;   
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8. To rename a profile, select it in the list, and click the Rename button; 

 
 
 

9. A Rename Profile screen will display.  Enter a 
new name for the profile and click the OK 
button; 

 
10. The Rename Profile screen will close and the renamed profile will display in the list.  In the 

example here, the imported profile was renamed “Post Process Demo 2”. 

 
 

 It is important to note that imported profiles should be inspected after import to review profile 
settings.  Profiles may deal with data that exists in database tables that may have changed since 
the last time the profile was exported.  Examples of such tables include (but are not limited to): 
freight tables; pallet plans; batch report profiles; mass update profiles; statement generate 
settings; etc. 
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MINIMIZING VERSUS EXITING THE CONTROL CENTER 

The AWAM Control Center and the service are two separate executables that run independent of one 
another.  It is important to understand how minimizing and exiting affects both the Control Center and 
the service. 

MINIMIZING 

Minimizing the Control Center allows the user to have full control over AWAM without having to launch 
or already be in, DAT-MAIL.  Clicking the Minimize button located on the AWAM Control Center screen 

closes the Control Center and places an AWAM icon  in the computer or server’s System Tray.   
 

 
 
When the service is running, the icon will appear as in the 
image above (in color).  If the service is stopped, the icon will 
be black and white.   This is a visual cue to the user as to 
whether or not AWAM is running. 
 
If the user right-clicks on the icon while the service is running, 
the following command options will display:  Stop Service; 
Open Control Center; Stop Service and Exit; and Exit. 
 

• Stop Service:  Stops the service, but leaves the AWAM Control Center minimized in the computer 
or server’s System tray; 

• Open Control Center:  Opens/displays the AWAM Control Center on the computer or server 
(service remains running); 

• Stop Service and Exit:  Stops the service and exits the AWAM Control Center, unloading both 
from memory.  If this command is selected, the AWAM icon will no longer display in the 
computer or server’s System tray.  To re-open the AWAM Control Center, the user would have to 
do so through DAT-MAIL (refer to Launching the AWAM Control Center section above); and 

• Exit:  This leaves the service running; however, it exits the AWAM Control Center, unloading it 
from memory.  The service remains running; however, the user would have to access the Task 
Manager on the server or computer and display the ‘Processes’ tab for a visual confirmation (i.e. 
‘MDIMPSERVER707.exe’).  This applies to the computer or server only.   
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 Enable the SHOW PROCESSES FROM ALL USERS function in each Task Manager in order for the 
AWAM service’s process to display, since it will likely be running under a login different than what 
was used to log into the server or computer.  Depending upon which operating system the server 
or computer is using, this feature is enabled by either checking a box or clicking a button. 

 
 

 Do NOT use the Task Manager on the server or computer to stop the AWAM service! 

 
To re-open the AWAM Control Center, the user would have to do so through DAT-MAIL (refer to 
Launching the AWAM Control Center section above). 

 
 
If the AWAM Control Center is minimized and the service is not 
running, right-clicking on the icon in the computer or server’s 
System tray offers the following command options (note the 
System tray icon displays in black and white when the service is 
not running):  Start Service; Open Control Center; and Exit.   
 
 

• Start Service:  Starts the service and leaves the AWAM Control Center minimized in the server or 
workstation’s System Tray; 

• Open Control Center:  Opens/displays the AWAM Control Center on the server or workstation 
(service remains stopped); 

• Exit:  This leaves the service stopped and exits the AWAM Control Center, unloading it from 
memory.  If this command is selected, the AWAM icon will no longer display in the server or 
computer’s System Tray.  To open the AWAM Control Center and to start the service, the user 
would have to do so through DAT-MAIL (refer to Launching the AWAM Control Center section 
above). 
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EXITING 

Clicking on ‘File’ in the menu bar of the AWAM Control Center and selecting the ‘Exit’ menu option  will 
shut down the AWAM Control Center and unload it from memory.   
 

 
 
Clicking the red ‘X’ icon at the top right corner of the AWAM Control Center will 
also shut down the Control Center and unload it from memory.   
 
There will be no icon in the sever or workstation’s System Tray as occurs when the Minimize button is 
used.  The Control Center will close and the service will remain in the same state (i.e. Running or 
Stopped) that it was in when the ‘Exit’ menu option is selected or the red ‘X’ is clicked.   
 
Selecting the ‘Exit’ menu option or clicking the red ‘X’ icon have the same function as using the ‘Exit’ 
command accessible from the Minimized AWAM icon located in the server or workstation’s System Tray 
(refer to the Minimizing section above). 
 

 For troubleshooting needs it is important to be aware that the service can be running even if the 
AWAM Control Center is not displayed and/or there is no AWAM icon displayed in the server or 
workstation’s System Tray. 

PROFILES 

AWAM uses user-defined profiles which, depending on the profile type, control what happens during an 
import or after Mail.dat files are already in DAT-MAIL.   
 
Any number of profiles can be created, allowing the Client to have multiple configurations to handle 
different work flows or job types.  Profiles can be activated or deactivated as needed and multiple 
profiles can be active at the same time.  Only active profiles will be in play or applied when the service is 
running. 
 

 If an option exists in both DAT-MAIL and an AWAM profile, the setting for that option in the 
profile will override the DAT-MAIL setting when files are imported, merge, or have post 

processing actions applied to them using that profile.  
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Browse Profiles Screen 

Profile creation and maintenance occurs from within the Browse Profiles screen, which is accessible 
from both server and workstation installations of AWAM.  Access this screen by launching the AWAM 
Control Center and clicking the Edit Profiles button. 
 

 
 
The Browse Profiles screen consists of the following: 
 

 
 

• Profile Display Panel :  Displays Profile Name, Profile type, and Import Path for all profiles 
(active an deactive); 

o ‘Profile Name’:  Displays the name given to the profile by the user when the profile was 
created; 
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o ‘Profile Type’:  Displays what the profile type is.  Currently (March 2016) three types 
exists – Import; Merge; and PostProcess (refer to Profile Types section in this Guide for 
more information); 

o ‘Import Path’:  Displays the import path used by the profile.  AWAM requires the use of 
UNC path names for each ‘Import Path’, unless AWAM is being used in a single-
installation or stand-alone environment; 

 Mapped drives cannot be used with AWAM. 

A ‘Default Import Settings’ Import profile is automatically created and displayed in the Profile 

Display Panel  when AWAM is registered/activated and is intended for use for importing 
Mail.dat files into DAT-MAIL, only.  It is not used with merge or post-import processes.  This 
default profile is created using the same settings specified for the Daemon within DAT-MAIL.   
 

 Once AWAM’s ‘Default Import Settings’ Import profile is created the first time, it no longer is tied 
to the settings found in DAT-MAIL.  In other words, changing the settings for the Daemon in DAT-
MAIL will have no impact on the ‘Default Import Settings’ Import profile in AWAM. 

 

• Activate/Deactivate Button :  Clicking this button activates or deactivates a selected profile.  

Active profiles will have a green check mark  displayed next to them; 

• Clear Selections Button :  Clicking this button deactivates all active profiles in lieu of having to 
deactivate each profile individually; 

• Profile Type Filter :  Clicking this field’s drop down allows the user to filter the displayed 
profiles by Profile Type.  Currently (March 2016) there are three options available – Import; 
Merge; and PostProcess; 
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• Copy Button :  Clicking this button creates a copy of a selected profile, retaining all of the 
copied profile’s settings to make creating a new profile less labor-intensive; 

• Insert Button :  Clicking this button displays a list of the available profile types.  Selecting a 
specific profile type from the list creates a new, corresponding blank profile; 

• Change Button :  Clicking this button displays the configuration screen of a selected profile so 
that the user may make changes or updates to the profile’s settings; 

• Delete Button :  Clicking this button will delete a selected profile.  A dialog will display 
requiring the user to confirm that they want the profile to be deleted.  The Delete button is only 
active when a profile has been selected; 

• Close Button :  Clicking this button closes the Browse Profiles screen and returns the user to 
the Control Center.   

Profile Types 

There are three profile types:  Import; Merge; and Post Process.  A description of each is provided 
below. 

IMPORT PROFILES 

Import profiles control what happens to a Mail.dat file as it is being imported into DAT-MAIL; as well as, 
what happens immediately after the import itself is complete (i.e. post processing), including (but not 
limited to): 

• Applying mass updates that can clean up incorrect or missing data and/or help with By/For 
Identification;  

• Batch Print reports, tray tags, and pallet placards automatically;  

• Automatically set mailing and other dates;  

• Perform automated Mail.dat exports to PostalOne! or other applications;  

• Automatically palletize mailings;  

• Automatically perform entry point optimization for both drop shipping and copal with the ability 
to use different freight tables and options for your different clients or logistics companies 

• Create logical and/or physical sibling records;  

• Build floating batch manifests only for the jobs that need them;   

• Automatically generate statements and ready-to-pay update submissions to PostalOne!; and 

• Control the IM Barcode assignment options, overriding the global settings used by DAT-MAIL. 
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In order to use an Import profile, it must be in an ‘Active’ state in AWAM.  Import profiles that have a 

green check-mark displayed next to them in AWAM’s Browse Profiles screen are considered Active 
(refer to the Browse Profiles Screen section in this Guide for more information).   
 
For an Import profile to be ‘Active’, it must be tied to its own import folder.  Import folders are where 
new Mail.dat files preparing to be imported into DAT-MAIL are placed/stored.  Active Import profiles 
cannot share the same import folder.  If attempting to activate an Import profile that points to or uses 
the same import folder that another active profile is already using, an error will occur and the user will 
not be allowed to activate that Import profile. 
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MERGE PROFILES 

Merge profiles allow a Client to merge any number of Mail.dat jobs that have already been imported 
into DAT-MAIL, into one file.  When the files are merged, additional automated processes can also be 
applied to the newly merged file (i.e. post processing). 
 

 
 
In order to use a Merge profile, it must be in an ‘Active’ state in AWAM.  Merge profiles that have a 

green check-mark displayed next to them in AWAM’s Browse Profiles screen are considered Active 
(refer to the Browse Profiles Screen section in this Guide for more information).  Merge profiles can be 
activated right from within AWAM or, they can be activated while using the ‘AWAM Merge Mail.dat 
Files’ function in DAT-MAIL. 
 
Merge profiles do not use an “import” folder since the job-related Mail.dat files already exist within 
DAT-MAIL.  Mailers can create/use multiple Merge profiles; however, unlike Import profiles, all Merge 
profiles use the same ‘import path’.   
 
Merge processes begin from within DAT-MAIL using the ‘AWAM Merge Mail.dat Files’ function found 
under the ‘Utilities’ > ‘AWAM Processing’ menus, or by using the AWAM Merge icon located on DAT-
MAIL’s home screen. 
 

 
 

 For instructions on how to create a Merge profile, refer to the CREATING A MERGE PROFILE 
section in this Guide.  For instructions on how to use or apply a Merge profile, refer to the AWAM 
Merge Mail.dat Files Utility – Merge Profiles section in this Guide. 
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POST PROCESS PROFILES 

Unlike Import profiles that allow the user to set up automated processes that are applied to the file 
during its’ import into DAT-MAIL and immediately after, Post Process profiles allow the user to select 
files that are already in DAT-MAIL and have actions or processes applied to them after the fact.   
 

 
 
In order to use a Post Process profile, it must be in an ‘Active’ state in AWAM.  Post Process profiles that 

have a green check-mark displayed next to them in AWAM’s Browse Profiles screen are considered 
Active (refer to the Browse Profiles Screen section in this Guide for more information).  Post Process 
profiles can be activated right from within AWAM or, they can be activated while using the ‘AWAM Post-
Import Process Mail.dat Files’ function in DAT-MAIL. 
 
Post Process profiles do not use an “import” folder since the job-related Mail.dat files already exist 
within DAT-MAIL.  Mailers can create/use multiple Post Process profiles; however, unlike Import 
profiles, all Post Process profiles use the same ‘import path’.   
 
Post-import processes begin from within DAT-MAIL using the ‘AWAM Post-import Process Mail.dat Files’ 
function found under the ‘Utilities’ > ‘AWAM Processing’ menus, or by clicking the AWAM Post-Import 
Process icon located on DAT-MAIL’s home screen. 
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 For instructions on how to create a Post Process profile, refer to the CREATING A POST PROCESS 
PROFILE section in this Guide.  For instructions on how to use or apply a Post Process profile, refer 
to the AWAM Post-Import Process Mail.dat Files Utility – Post Process Profile section in this 
Guide. 

Activating & Deactivating Profiles 

All profiles can be activated and deactivated at any given time depending on a Mailer’s needs.  Profiles 

that have a green check-mark displayed next to them are Active.   
 
To activate a profile, select it from the list by single-clicking on it and then clicking the Activate button.   
 

 
 

 IMPORT PROFILES ONLY:  Each active Import profile must be tied to its own import folder.  Active 
Import profiles cannot share the same import folder.  If attempting to activate an Import profile 
that points to the same import folder that an active Import profile is already pointing to, an error 
will occur and the user will not be allowed to activate the second Import profile. 

 
 
To deactivate a profile, select it by single-clicking on it and and click the Deactivate button.   
 
To deactivate all activated profiles, click the Clear Selections button. 
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CREATING & USING PROFILES 

As stated earlier, there are three profile types available for use:  Import; Merge; and Post Process.  A 
description of each is provided under the Profile Types section in this Guide.  How to create each of the 
three profiles types along with instructions on how to use or apply each is documented below.   
 

 Import profiles are used by AWAM and the AWAM File Manager.  Merge and Post Process 
profiles are used by the AWAM Processing utility found in DAT-MAIL. 

CREATING & USING AN IMPORT PROFILE 

 For a description of Import profiles, refer to the IMPORT PROFILES section in this Guide. 

To create a profile and then import a file, perform the following: 
 

 This procedure assumes that the AWAM service has already been installed and is running. 

1. From DAT-MAIL, click the AWAM icon to launch AWAM; 

 
 

2. If operating on the server in a server with workstation(s) environment or the computer in a 
single-installation/stand-alone environment, the AWAM Control Center will display; 

3. From the AWAM Control Center, click the Edit Profiles button; 
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4. The Browse Profiles screen will display.  Any/all previously created profiles (active and 
deactive) will be listed, along with the import path they use.  A ‘Default Import Settings’ 
profile is automatically provided when AWAM is registered/activated and is intended for use 
for importing Mail.dat files into DAT-MAIL, only.  It is not used with merge or post-import 
processes.  This default profile is created based on the settings specified for the Daemon 
within DAT-MAIL. 

 Once AWAM’s ‘Default Import Settings’ profile is created the first time, it no longer is tied to the 
Daemon settings in DAT-MAIL.  In other words, changing the settings for the Daemon in DAT-
MAIL will have no impact on the ‘Default Import Settings’ profile in AWAM. 

 The ‘Default Import Settings’ profile can be changed within AWAM by select the profile and 
clicking the ‘Change’ button. 

To create a new profile, click the Insert button and select ‘New Import Profile’; 

 
 

 All Import profiles created by clicking the ‘Insert’ button will initially be set up with the same 
settings as the ‘Default Import Settings’ profile. 

5. A Profile Will Be Added screen will display.  Enter a profile-specific name (in the example 
here, “Auto Freight Plan” is entered as the profile name”; 
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6. From within the screen’s ‘Import’ tab, click the browse button for the ‘Source Path’ field.  
Locate the ‘\\...WB\mail.dat’ folder on the server and create a new directory specifically for 
the import folders used by AWAM Import profiles (in the example here, a new directory 
called “AWAMImportProfiles” is created – refer to image located under step 7 below); 

 In a server with workstation(s) environment, it is necessary that the "AWAMImportProfiles" 
directory (and any import folders) be accessible by all workstations.  One way to accomplish this 
is by creating the new directory (and any import folders) under the “\\...WB\mail.dat” folder on 
the server.  This ensures the contents of the “AWAMImportProfiles” directory or folder will be 
accessible by all workstations.  In addition, UNC path names must also be used. 

 

 Once the "AWAMImportProfiles" directory is created, this step (step 6), does not need to be 
repeated when other, new Import profiles are inserted/created in AWAM.  The import folders for 
all/any new AWAM Import profiles should be created within or under the "AWAMImportProfiles" 
directory on the server (i.e. "\\...WB\mail.dat\AWAMImportProfiles"). 

 
7. Within the new ‘AWAMImportProfiles’ directory, create the import folder to be used by the 

new, “Auto Freight Plan” Import profile (in the example here, the import folder 
“AutoFrtPlan” is created/selected; 

Create and/or select a folder in the ‘\\...WB\mail.dat’ location to save any processed files to; 
as well as, the files that failed import (in the example used here, the default folders are 
used, i.e. “processed” and “rejected”)); 
 

 
 
 

8. Set or enable any other actions available on the ‘Import’ tab that should be completed when 
a file is imported into DAT-MAIL using this Import profile; 
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 If an option exists in both DAT-MAIL and an AWAM profile, the setting for that option in the 
profile will override the DAT-MAIL setting when files are imported, merge, or have post 
processing actions applied to them using that profile.  

 
 

 The ‘Fast Network Option’ is intended for users in server with workstation(s) environment; 
specifically, those users doing single file imports from a workstation.  If a workstation user is 
attempting to import files over a network, having this option enabled will make a copy of the 
Mail.dat file in the workstation’s TEMP folder to assist with speeding up the import process.  If 
importing is being done on a server (or computer in stand-alone or single-installation 
environment) where the data resides, there is no benefit to enabling this option. 

 
9. Select (click) the ‘Post Processing’ tab.  From within the screen’s ‘General Settings’ tab, set 

or enable any of the available actions that should occur after the file has been imported into 
DAT-MAIL; 
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 Selecting the option to ‘Palletize Pallets Automatically’ will enable and display the Post 
Processing tab’s ‘Palletizing’ screen to be used for additional configurations. 

 

 The DAT-MAIL Toolbox and/or the DAT-MAIL Editor with the Palletization add-on is required to be 

able to use the Palletizing option (refer to the REQUIREMENTS section in this Guide). 

 
 

 Selecting the option to ‘Run Planalyzer’ will enable and display the Post Processing tab’s 
‘Planalyzer’ screen to be used for additional configurations. 

 The DAT-MAIL Toolbox is required to be able to use the Planalyzer option (refer to the 
REQUIREMENTS section in this Guide). 
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10. Select (click) the ‘Auto Exports’ tab.  Set or enable any of the available actions that should 
occur after the file has been imported into DAT-MAIL; 

 
 

11. Select (click) the ‘Dates’ tab.  Set or enable any of the available actions that should occur 
after the file has been imported into DAT-MAIL (for more information on how to use the 
functions located under the ‘Dates’ tab, refer to the USING THE ‘DATES’ TAB section in this 
Guide); 
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12. Select (click) the ‘Intelligent Mail Barcode’ tab.  Set or enable any of the available actions 
that should occur after the file has been imported into DAT-MAIL (for more information on 
how to use the functions located under the ‘Intelligent Mail Barcode’’ tab, refer to the 
USING THE ‘INTELLIGENT MAIL BARCODE’ TAB section in this Guide); 

 
 

13. Click the OK button when finished entering all of the necessary criteria for the new Import 
profile (i.e. “Auto Freight Plan”).   

14. The Profile Will Be Added screen will close and the Browse Profiles screen will display and 
contain the newly created profile (i.e. ‘Auto Freight Plan’); 
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15. To activate the new profile ‘Auto Freight Plan’, single-click on the profile to select it and click 

the Activate button.  A green check mark will display next to the profile signifying that the 
profile is now active; 

 
 

16. Click the Close button to close the Browse Profiles screen; 

17. As Mail.dat files are dropped into their corresponding Import folders, the Control Center will 
display the file names and report on their progress in both the Activity and History tabs as 
the service applies the appropriate profile (in the example here, the ‘Auto Freight Plan’ 
profile is being applied); 
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The images below provide an example of when the processing of the file completes.  
Scrolling right in the Control Center provides more status information such as the date/time 
the process completed.  Scrolling right also displays the Import Path the profile used; 
 

 
 

 
 
The job can also be referenced back in DAT-MAIL using the ‘Job ID’. 

 

 
 

 While the processing is taking place, the user is free to use DAT-MAIL and/or any other available 
software on the computer or server and workstations without interruption.   
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 The AWAM Control Center can be minimized or closed while the service is running and jobs are 
being processed/imported (refer to the AWAM Control Center - In Detail section in this Guide for 
more information).  Be aware; however, that if the Control Center is exited completely, the 
existing status information will be lost from the Activity tab.  It will; however, remain in the 

History tab.  

 
 
 

CREATING A MERGE PROFILE 

 For a description of Merge profiles, refer to the MERGE PROFILES section in this Guide. 

Merge profiles are used in conjunction with DAT-MAIL’s ‘AWAM Merge Mail.dat Files’ utility, which is 
used for Mail.dat files that have already been imported into DAT-MAIL.  They can be created prior to use 
from within AWAM, or they can be created while using the aforementioned utility.   
 
This section describes how to create a Merge profile through AWAM (ahead of time).  Instructions for 
using/applying a Merge profile can be found under the AWAM Merge Mail.dat Files Utility – Merge 
Profiles section in this Guide. 
 
Merge profiles can be created from the server (or computer in a stand-alone/single-installation 
environment), or from a workstation in a server with workstation(s) environment. 
 
To create a Merge profile, perform the following: 
 

 This procedure assumes that AWAM has already been launched at least once on the server. 

1. From DAT-MAIL, click the AWAM icon to launch AWAM; 
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2. The AWAM Control Center will display.  Click the Edit Profiles button; 

 
 

3. The Browse Profiles screen will display.  Any/all previously created profiles (active and 
deactive) will be listed, along with the import path they use.  To create a new profile, click 
the Insert button and select ‘New Merge Profile’; 

 
 

4. A Profile Will Be Added screen will display.  Enter a profile-specific name (in the example 
here, “Merge Test” is entered for the Merge profile’s name); 
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5. Under the ‘Merge’ tab, set or enable the appropriate functions: 

 
 

o  Fast Network Option:  This option is intended for users in server with workstation(s) 
environment, where the data resides on a machine other than the workstation, to help 
speed up file processing.  If the file processing is being done on a server (or computer in 
stand-alone or single-installation environment) where the data resides, there is no 
benefit to enabling this option. 

o  Job Number and Job Name:  These are free-text fields where the user can enter any 
alpha-numeric value.  Both of these fields coincide with their counterparts found in DAT-
MAIL.  When the selected files are merged, whatever value has been entered in these 
two fields will become the new Job Number and Job Name for the resulting Mail.dat file.   

If nothing is entered in the Job Number field by the user, a system-generated Job 
Number will be assigned in DAT-MAIL.  This system-generated Job Number uses the 
date (i.e. MMDD) and the time (i.e. HHMM).  For example, if files were merged on 
March 28 at 12:31 p.m., the new Job Number in DAT-MAIL would display as:  
“03281231”. 
 
If nothing is entered in the Job Name field by the user, a system-generated Job Name 
will be assigned in DAT-MAIL.  This system-generated Job Name uses the date (i.e. YYYY-
MM-DD) and the time (HH:MM).  For example, if files were merged on March 28, 2016 
at 12:31 p.m., the new Job Name in DAT-MAIL would display as: 
“2016-03-28 12:31”. 
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o  Estimated Mail Date; In Home Delivery Date; and Delivery Window:  In the Mail.dat 
file created by the merge, these fields will be populated using the displayed values.  Any 
modifications to the displayed values by the user will be used in the new Mail.dat file.  

o  Merge Type:  Click the drop down arrow to select from the list of available merge 
types.  The default value is “Normal without OCI”.  It is important that this value is set 
before proceeding with the file merge. 

 
 

o  Various Merge Actions:  Select (check) any additional options to be completed when 
the selected files are merged into a new, single Mail.dat file.  The options shown on the 

screen will be enabled or disabled depending on which Merge Type  is selected. 

 
6. Click the ‘Post Processing’ tab.  From within the screen’s ‘General Settings’ tab, set or enable 

any of the available actions that should occur in the new Mail.dat file created as a result of 
the merge process; 

 If an option exists in both DAT-MAIL and an AWAM profile, the setting for that option in the 
profile will override the DAT-MAIL setting when files are imported, merge, or have post 

processing actions applied to them using that profile.  
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 Selecting the option to ‘Palletize Pallets Automatically’ will enable and display the Post 
Processing tab’s ‘Palletizing’ screen to be used for additional configurations. 

 

 The DAT-MAIL Toolbox and/or the DAT-MAIL Editor with the Palletization add-on is required to be 
able to use the Palletizing option (refer to the REQUIREMENTS section in this Guide). 

 
 

 Selecting the option to ‘Run Planalyzer’ will enable and display the Post Processing tab’s 
‘Planalyzer’ screen to be used for additional configurations. 

 The DAT-MAIL Toolbox is required to be able to use the Planalyzer option (refer to the 
REQUIREMENTS section in this Guide). 
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7. Select (click) the ‘Auto Exports’ tab.  Set or enable any of the available actions that should 
occur in the new Mail.dat file after the merge is complete; 

 
 

8. Select (click) the ‘Dates’ tab.  Set or enable any of the available actions that should occur in 
the new Mail.dat file after the merge process is complete (for more information on how to 
use the functions located under the ‘Dates’ tab, refer to the USING THE ‘DATES’ TAB section 
in this Guide); 
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9. Select (click) the ‘Intelligent Mail Barcode’ tab.  Set or enable any of the available actions 
that should occur in the new Mail.dat file after the merge process is complete (for more 
information on how to use the functions located under the ‘Intelligent Mail Barcode’’ tab, 
refer to the USING THE ‘INTELLIGENT MAIL BARCODE’ TAB section in this Guide); 

 
 

10. Click the OK button when finished entering all of the necessary criteria for the new Merge 
profile (i.e. “Merge Test”).   

11. The Profile Will Be Added screen will close and the Browse Profiles screen will display and 
contain the newly created profile (i.e. “Merge Test”); 

 
 

12. At this time, the new profile “Merge Test” can be activated for use by selecting it and 
clicking the Activate button… 
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… or the profile can be activated later when it is selected for use through the ‘AWAM Merge 
Mail.dat Files’ utility in DAT-MAIL.   
 

 
When the profile is active, a green check mark will display next to it in the list; 
 

 
 

13. Click the Close button to close the Browse Profiles screen.     

 Instructions for using/applying Merge profiles can be found under the AWAM Merge Mail.dat 
Files Utility section in this Guide. 

CREATING A POST PROCESS PROFILE 

 For a description of Post Process profiles, refer to the POST PROCESS PROFILES section in this 
Guide. 

Post Process profiles are used in conjunction with DAT-MAIL’s ‘AWAM Post-Import Process Mail.dat 
Files’ utility, which is used with Mail.dat files that have already been imported into DAT-MAIL.  They can 
be created prior to use from within AWAM, or they can be created while using the aforementioned 
utility.   
 
This section describes how to create a Post Process profile through AWAM (ahead of time).  Instructions 
for using/applying a Post Process profile can be found under the AWAM Post-Import Process Mail.dat 
Files Utility – Post Process Profile section in this Guide. 
 
Post Process profiles can be created from the server (or computer in a stand-alone/single-installation 
environment), or from a workstation in a server with workstation(s) environment.  To create a Post 
Process profile, perform the following: 
 

 This procedure assumes that AWAM has already been launched at least once on the server. 

1. From DAT-MAIL, click the AWAM icon to launch AWAM; 
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2. The AWAM Control Center will display.  Click the Edit Profiles button; 

 
 

3. The Browse Profiles screen will display.  Any/all previously created profiles (active and 
deactive) will be listed, along with the import path they use.   To create a new profile, click 
the Insert button and select ‘New Post Process Profile’; 
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4. A Profile Will Be Added screen will display.  Enter a profile-specific name (in the example 
here, “Post Profile Test” is entered for the Post Process profile’s name); 

 
 

5. From within the screen’s ‘General Settings’ tab, set or enable any of the available actions 
that should occur in the selected Mail.dat file(s) that is in DAT-MAIL; 

 If an option exists in both DAT-MAIL and an AWAM profile, the setting for that option in the 
profile will override the DAT-MAIL setting when files are imported, merge, or have post 
processing actions applied to them using that profile.  

 
In the example here, the ‘Apply Mass Update’ function is enabled and the existing Mass 
Update Profile of “CHANGE PERMIT” is selected.  This Mass Update Profile is set up to 
change any existing permit to a permit value of “123456” in the selected Mail.dat’s MPA file; 
 

 For more information about the ‘Run Mass Update’ function, refer to the USING THE ‘RUN MASS 
UPDATES’ FUNCTION section in this Guide. 

 

 
 
 

 Selecting the option to ‘Palletize Pallets Automatically’ will enable and display the ‘Palletizing’ 
tab to be used for additional configurations. 
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 The DAT-MAIL Toolbox and/or the DAT-MAIL Editor with the Palletization add-on is required to be 

able to use the Palletizing option (refer to the REQUIREMENTS section in this Guide). 

 
 

 Selecting the option to ‘Run Planalyzer’ will enable and display the ‘Planalyzer’ tab to be used for 
additional configurations. 

 

 The DAT-MAIL Toolbox is required to be able to use the Planalyzer option (refer to the 
REQUIREMENTS section in this Guide). 
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6. Select (click) the ‘Auto Exports’ tab.  Set or enable any of the available actions that should 
occur in the selected Mail.dat file(s) that is in DAT-MAIL; 

 
 

7. Select (click) the ‘Dates’ tab.  Set or enable any of the available actions that should occur in 
the selected Mail.dat file(s) that is in DAT-MAIL (for more information on how to use the 
functions located under the ‘Dates’ tab, refer to the USING THE ‘DATES’ TAB section in this 
Guide); 
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8. Select (click) the ‘Intelligent Mail Barcode’ tab.  Set or enable any of the available actions 
that should occur in the selected Mail.dat file(s) that is in DAT-MAIL (for more information 
on how to use the functions located under the ‘Intelligent Mail Barcode’ tab, refer to the 
USING THE ‘INTELLIGENT MAIL BARCODE’ TAB section in this Guide); 

 
 

9. Click the OK button when finished entering all of the necessary criteria for the new Post 
Process profile (i.e. “Post Process Test”).   

10. The Profile Will Be Added screen will close and the Browse Profiles screen will display and 
contain the newly created profile (i.e. “Post Process Test”); 

 



AWAM™ 

User Guide  Creating & Using Profiles 

©2018 Window Book, Inc.  All Rights Reserved.  Page 61 of 105 

11. At this time, the new profile “Post Process Test” can be activated for use by selecting it and 
clicking the Activate button… 

 
 

… or the profile can be activated later when it is selected for use through the ‘AWAM Merge 
Mail.dat Files’ utility in DAT-MAIL.   
 

 
 

When the profile is active, a green check mark will display next to it in the list; 
 

 
 
 

12. Click the Close button to close the Browse Profiles screen.     

 Instructions for using/applying Post Process profiles can be found under the AWAM Post-Import 

Process Mail.dat Files Utility – Post Process Profile section in this Guide. 
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USING THE ‘DATES’ TAB 

The ‘Dates’ tab is found in the ‘Post Processing’ section of all three profile setup screens (i.e. Import, 
Merge, and Post Process).  The functionality associated with the ‘Dates’ tab allows Clients to change/set 
the actual or correct production mail dates found in a Mail.dat’s CSM file.  When the profile is applied, 
the dates specified in the profile will replace what currently exists in the Mail.dat file. 
 

 
 
The possible date changes or specifications are predicated on the value or setting that exists in the 
Mail.dat file for the ‘USPS Pickup’ date (also found in the CSM file). 
 
For example, if the ‘USPS Pickup’ value is set to ‘Y’, the ‘Scheduled Ship Date [CSM 1173]’ must be 
populated with a date.  If ‘Blank/Clear’ is selected for the ‘Scheduled Ship Date [CSM 1173]’, when the 
user clicks the OK button to close the Profile Will Be Added screen (i.e. creating new profile) or Profile 
Will be Changed screen (i.e. changing an existing profile), the following Warning dialog will display: 
 

 
 

 All/any validation rules are applied when the ‘OK’ button is clicked, not while setting the values 
for the individual dates. 

 
The available settings for ‘USPS Pickup’ are:  ‘Existing’; ‘Blank’; ‘No’; and ‘Yes’. 
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The individual dates that can be specified are:  

• Scheduled Ship Date [CSM-1172]; 

• Scheduled Induction Date [CSM-1117]; 

• Scheduled Pick Up Date [CSM-1177]; 

• Actual Container Ship Date [CSM-1113]; 

• In Home Date [CSM-1115]; and 

• Postage Statement Mailing Date [CSM-1184]. 

For each of these dates, depending upon the value specified for the ‘USPS Pickup’ field, the user has the 
ability to use the existing date that is in the CSM file (i.e. ‘Existing’); use the current date (i.e. ‘Today’); 
use a specific date (i.e. ‘Specific Date’); or if there is no date in the original file, leave the field blank (do 
not insert a date), i.e. ‘Blank/Clear’.   
 
In addition, if ‘Existing’ or ‘Today’ is selected, the user can add or subtract a specific number of days to 
the existing date or today’s date for specifying the actual date to be populated in the imported file. 
 

 
 
Selecting ‘Specific Date’ displays an actual calendar for selecting an actual date to be used. 
 

 
 
 
Along with the possible date changes or specifications that are predicated on the value or setting that 
exists in the Mail.dat file for the ‘USPS Pickup’ date, there are also dependencies that occur between the 
individual date fields.  For example, the ‘Scheduled Induction Date [CSM 1117]’ must be greater than or 
equal to the ‘Scheduled Ship Date [CSM-1172]’ if the ‘Scheduled Ship Date [CSM-1172]’ is populated.   
 
In the example being used here, the ‘Scheduled Induction Date [CSM 1117]’ is less than the date set for 
the ‘Scheduled Ship Date [CSM-1172]’.  
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Once the user clicks the OK button to exit the screen, the following Warning dialog will display: 
 

 
 

 If the import date is to be “today’s date”, make sure to select the setting of ‘Today’ for the import 
profile vs. selecting ‘Specific Date’ and specifying today’s date on the calendar provided.   

 
Another date dependency is that the ‘In-Home Date [CSM-1115]’ must be greater than or equal to the 
Scheduled Ship Date [CSM-1172]’ and ‘Actual Container Ship Date [CSM-1113]’ if both are populated. 
 

 Any/all validation rules are applied when the ‘OK’ button is clicked, not while setting the values 
for the individual dates. 

USING THE ‘INTELLIGENT MAIL BARCODE’ TAB 

Mailers can override their global barcode assignment settings specified in DAT-MAIL’s Setup screen (i.e. 
File > Program Settings > Program Setup) by enabling an override function located in the ‘Intelligent Mail 
Barcode’ tab available in AWAM profiles.   
 

 
IM Barcode global settings in DAT-MAIL’s ‘Setup’ screen. 
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The ‘Intelligent Mail Barcode’ tab is part of the ‘Post Processing’ section of all three AWAM profile setup 
screens (i.e. Import, Merge, and Post Process – see image below).  The settings in this tab allow Mailers 
to customize or change their Intelligent Barcode assignment options for specific files – they can override 
DAT-MAIL’s global settings when needed and/or re-register their IM Barcodes.  
  
Mailers can create two profiles – each using their own import folder.  One folder would be for jobs that 
use the global settings for IM Barcodes and the second, for jobs that use different settings.  The option is 
also available to have the barcodes assigned when the tags/placards are actually printed, or when the 
import, merge, or post import process is run.  
  
The options are the same in all three profile types, with one exception – AWAM’s Post Process profile. 
 

 
 
With Post Process profiles, Mailers have to explicitly turn on or enable the option to re-register IM 
Barcodes, and then specify whether or not to override the existing, global barcode settings (refer to the 
image above).  This is to avoid having AWAM automatically re-register IM Barcodes when performing a 
post process task using an AWAM Post Process profile.  This same concern is not applicable for Import 
and Merge profiles.  
  
The settings for the IM Barcodes available in Import and Merge profiles automatically default to the 
current global settings found in DAT-MAIL, until the Mailer decides to change them.  Post Process 
profiles default to not registering barcodes regardless of global settings. 
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IM Barcode settings applied to a file are now retained and can be viewed by the Mailer in the Jobs List 
browse in DAT-MAIL.  Users will be able to easily determine whether or not global settings were used. 
 

 
 

 A few items to keep in mind when using this new functionality:   

▪ If a Mailer uses their presort program to print tray tags or pallet placards, they should never enable DAT-
MAIL to overwrite those barcodes unless they are willing to re-print them with DAT-MAIL; and 

▪ If Mailers use DAT-MAIL to overwrite tray and/or pallet placards, they must use DAT-MAIL to print their 
tray tags and placards after they are overwritten.   

 This same override functionality for Intelligent Mail Barcodes is also available in the ‘Merge 
Mail.dat files’ and ‘Split a Mail.dat file’ functions accessible from the ‘Utilities’ menu in DAT-
MAIL; as well as, the CSM, PDR, and PBC file views accessible from the Advanced Navigator, also 

in DAT-MAIL. 

 If a Mailer does not have the option to register IM Barcodes enabled in DAT-MAIL’s global 
settings, the override feature will not display/be available in the manual merge and split 
functions found in DAT-MAIL, or the CSM, PDR, and PBC file views accessible from the Advanced 
Navigator. 

 For some examples of import profiles that use the ‘Intelligent Mail Barcode’ tab, refer to 
APPENDIX 1 – EXAMPLE PROFILES in this document. 
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USING THE ‘RUN MASS UPDATES’ FUNCTION 

The ‘Run Mass Updates’ function is found in the ‘Post Processing’ section of all three profile setup 
screens (i.e. Import, Merge, and Post Process); specifically, the ‘General Settings’ tab.   
 

 The Mass Update function can also be accessed directly from within DAT-MAIL by selecting the 
‘Utilities’ menu from DAT-MAIL’s main screen and selecting ‘Apply Mass Update’. 

 
 
The ‘Run Mass Update’ function allows the user to populate many fields in Mail.dat files with specific 
values for different situations and Clients; as well as, perform conditional replacements.  For example, a 
user can define Mail Owner MIDs or CRIDs in a Mass Update profile and set it to run automatically in an 
AWAM profile created for that same Client.  The result of this would be, having the by/for information 
be applied automatically for the Client, along with the execution of any other functions that are 
specified in the AWAM profile. 
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Enabling and Selecting A Mass Update Profile 

To enable the ‘Run Mass Update’ function in an AWAM profile and select a Mass Update profile to 
apply, perform the following: 
 

 The ‘Run Mass Updates’ function is found in the ‘Post Processing’ section of all three profile setup 
screens (i.e. Import, Merge, and Post Process); specifically, under the ‘General Settings’ tab. For 
documentation purposes, the procedure for enabling and selecting a Mass Update profile for use 
is demonstrated using an AWAM Import profile.   

1. To enable the ‘Mass Update’ function, check (click) the corresponding box.  The Mass 
Update Setup button will enable (become active or un-ghosted); 

 
 
 

2. Click the Mass Update Setup 
button. The Mass Update Profiles… 
screen will display.   

Pre-existing profiles will be listed in 
the ‘Title’ window.  If the Mass 
Update profile to be applied is listed, 
highlight it and click the Select 
button; 
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3. The Mass Update Profiles… screen will close and the Profile Will Be Added screen (i.e. 
creating a new profile) or the Profile Will Be Changed screen (i.e. modifying an existing 
profile) will display.  The selected Mass Update Profile will show next to the ‘Run Mass 
Update’ function; 

 
 

 Only one Mass Update profile can be included in any AWAM profile. 

To change the selected Mass Update profile, click the Mass Update Setup button and select a different 
profile from the list or create a new one to select (refer to the CREATING A MASS UPDATE PROFILE 
section for more information). 

 
To turn off or disable the Mass Update function all together, un-check the 
function’s corresponding box. 
 

VIEWING BATCH REPORT PDF FILES 

If mailers are running Batch Reports and simultaneously generating PDFs of those reports as part of an 
AWAM profile, they can use the historical activity reported in the History tab of AWAM’s Control Center 
to be able to view the resulting PDFs.   
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Simply right-click on the completed file’s line-item and select “Show Results”.   
 

 
 
The PDFs that were created from that file will be displayed.  To view a PDF, simply right-click anywhere 
on the report’s line item and select ‘Show File’. 
 

 
 
 

AWAM PROCESSING UTILITIES IN DAT-MAIL 

This section describes the AWAM Processing utilities found in DAT-MAIL; specifically, the ‘AWAM Merge 
Mail.dat Files’ utility, and the ‘AWAM Post-Import Process Mail.dat Files’ utility. 
 
AWAM’s Merge and Post Process profiles are used by these utilities, as they are intended for Mail.dat 
files that have already been imported into DAT-MAIL.   

AWAM Merge Mail.dat Files Utility 

The ‘AWAM Merge Mail.dat Files’ utility uses Merge profiles which stipulate what type of merge is to 
occur and what is to happen during the merge process; as well as, specify any actions that should be 
performed on the new Mail.dat file that is created as a result. 
 
 
 
 
 



AWAM™ 

User Guide  Creating & Using Profiles 

©2018 Window Book, Inc.  All Rights Reserved.  Page 71 of 105 

The ‘AWAM Merge Mail.dat files’ utility is accessed within DAT-MAIL by selecting ‘Utilities’ > ‘AWAM 
Processing’ > ‘AWAM Merge Mail.dat files’, or by clicking the AWAM Merge icon located on DAT-MAIL’s 
home screen. 
 

 
 

The utility displays all of the existing Mail.dat files .   
 

 
 
Files can be sorted and viewed by a number of different fields.  These field-specific sort/view options are 

provided in tab format across the top of the display window .  Clicking a specific tab will update the 
job list to display by the that tab’s corresponding field. 
 
Once the available Mail.dat files are displayed in the desired sort order, the user can search for specific 

jobs easily by entering a value specific to the field sort selected .  In the numbered screen image being 
used here (above), the selected sort order is by ‘Job No.’ (i.e. job number); therefore, the user can enter 
text or numbers pertaining to Job Numbers to further narrow their search for a specific job(s).  The 
search begins at the beginning of the field and will not identify jobs with the same search criteria if it 
occurs mid field.  When search criteria is entered, the user must tab out of the field to launch the 
search. 
 
Example 1:  Job Number = 2015_12NL001 
Search Criteria Entered = “2015” (minus the quotation marks) 
Returned Results:  The first job discovered to have a Job Number beginning with “2015” will be 
highlighted. 
 



  AWAM™ 

Creating & Using Profiles  User Guide 
 

Page 72 of 105  ©2018 Window Book, Inc.  All Rights Reserved. 

 

Example 2:  Job Number = “2015_12NL001” 
Search Criteria Entered = “12NL001” 
Returned Results:  None found 
 

 
 

If the ‘Scan Barcode’ option  is selected (checked), users can scan or enter in a barcode of a job that is 

to be merged.  When the barcode is scanned in, it will display in the search field .  If the correct job is 

identified, it will display in the job display window and be automatically tagged. 
   
When a desired job is found, it can be tagged for merging by either clicking in the empty box to the left 
of the job’s line item, or by clicking anywhere on the job’s line item to highlight it and then clicking the 

single red check-mark located at the top of the screen .  A job is tagged when a check-mark displays in 
the box located to the left of the job’s line item.   
 

 
 
 
 
A block of jobs can be tagged simultaneously, such as for mailers 
doing OCI tray-based copal, by using the Special Tag utility.  This 
utility allows users to search for a block of jobs using the First Mailing 
Date, Mail Class, Processing Category, and Release Status fields as 

filters.  To open this utility, click the Special Tag button . 
 
 
 
When all of the filters are set and the Process button is clicked, the merge utility identifies all of the jobs 
that meet the set criteria and tags (checks) them automatically for the user. 
 
Individual jobs can be un-tagged (unchecked) by clicking anywhere on a single job’s line item to highlight 
it and clicking the single red check-mark located at the top of the screen.  The use can also simply click 
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on the check-mark located to the left of the specific job’s line item.  If there are multiple jobs tagged and 
the user wishes to un-tag (de-selected) all of them, they can do so all at once by clicking the double-red 

check-mark . 
 
A specific Job Number and/or a Job Name can be applied to the new Mail.dat that will be created by the 

merge by entering the values in the utility screen .  Keep in mind that if values for either field are 
entered here, they will over write whatever is stipulated in the AWAM merge profile being used. 
 

HOW TO USE THE MERGE UTILITY 

 New Merge profiles can be created during the use of this utility; however, for documentation 
purposes, the following procedure uses an existing Merge profile that was created through 
AWAM (refer to the CREATING A MERGE PROFILE section in this Guide). 

To perform a merge using the AWAM Merge Mail.dat files utility in DA-TMAIL, do the following: 
 

 This procedure assumes that the AWAM service has already been installed and is running. 

1. From DAT-MAIL’s main or  home screen, click the ‘AWAM Merge’ icon; 

2. The Select Mail.dat Files to Merge screen will display.  Click the tab corresponding to how 
the available Mail.dat files should be listed (e.g. “by Job No.”); 

3. Located and tag the jobs or files to be merged.  In the example here, four jobs/files are to be 
merged.  In addition, a Job Number of “MERGE:  Auto_CNE-1” and a Job Name of 
“Auto_CNE-1 Revs 1-4 Merged” is applied; 
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 Keep in mind that the Job Number and Job Name entered here in the merge utility will over-write 

the Job Number and Job Name (if any) specified in the AWAM merge profile being used/applied. 

4. Click the Submit to AWAM button (clicking the Cancel button will abort the merge process 
and close the Select Mail.dat Files to Merge screen).  The Select Mail.dat Files to Merge 
screen will close and AWAM’s Browse Profiles screen will display.  All existing Merge profiles 
will be listed whether or not they are active; 

At this point, the user has three options:   
 
A. Highlight the Merge profile to be used and click the Select button (if the profile selected 

is not active, the button label will read “Activate & Select”); 

 
 

B. Click the Insert button and create a new Merge profile to use.  Once created, it will 

display in the list and can be highlighted and selected (i.e. Select button); or 

C. Highlight and click an existing Merge profile and click the Change button to make 

modifications to the existing profile.   

In the example here, the existing profile “Merge Test” is highlighted and the Change button 
is clicked in order to change the existing profile based on the jobs selected for merging 
(option C above); 
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5. The profile’s Profile Will Be Changed screen will display.  Make any necessary changes to the 
existing Merge profile:   

In the example here, the Merge Type was changed to “Normal with OCI”. 
 

 
 

 Keep in mind that the changes made to the Merge profile are permanent and will be applied the 
next time the profile is selected for a merge process unless changed by the user, first.  Window 
Book strongly recommends viewing the contents of any Merge profile that is intended for use 

before applying it to files selected for merging. 

6. Click the OK button when finished (clicking the Cancel button will abort all the changes 
made and close the screen).   

7. The Profile Will Be Changed screen will close and the Browse Profiles screen will display.  
Make sure the correct Merge profile is highlighted (in the example here, “Merge Test”) and 
click the Select button to begin the merge process; 

 Clicking the ‘Select’ button immediately starts the merge process.  There is no confirmation dialog 

that displays and no way to stop or abort the merge process once the ‘Select’ button is clicked. 
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8. An Info dialog will display. Click the OK button to resolve (close) the 

dialog and continue; 

 
9. As the merge process begins, AWAM’s Control Center screen 

displays the status of the merge process in both the Activity and History tabs; 

 
 

 
As the merge process continues, the AWAM’s Control Center screen will update accordingly, 
until the merge process is complete; 

 

 
 

 
 

 
 

 Depending upon what functions or processes the AWAM merge profile is set up to run, the 
progress statuses as depicted in the above screen images may vary. 

 
10. Once the merge process is complete, click the open folder icon located on DAT-MAIL’s main 

or home screen to view a list of the Mail.dat files or jobs; 
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11. The Select Mail.dat File To Open screen will display.  Locate the new Mail.dat file created as 
a result of the merge (refer to job line outlined in red in the screen image below).  Note that 
the Job Number and Job Name correspond with what was specified in the Merge utility 
(documented in step 3 above; 

 
 

In addition, the sum of the Total Piece count of the four files that were merged (refer to the 
jobs outlined in green in the screen image above), equals the Total Piece count of the new 
Mail.dat file (i.e. 30,251 x 4 = 121,004).  The merge process is complete. 

AWAM Post-Import Process Mail.dat Files Utility 

The ‘AWAM Post-Import Process Mail.dat Files’ utility located in DAT-MAIL uses Post Process profiles to 
stipulate what actions are to be taken on selected Mail.dat files that are already in DAT-MAIL (i.e. after 
they’ve been imported). 
 
The ‘AWAM Post-Import Process Mail.dat files’ utility is accessed within DAT-MAIL by selecting ‘Utilities’ 
> ‘AWAM Processing’ > ‘AWAM Post-import Process Mail.dat files’, or by clicking the AWAM Post-Import 
Process icon on DAT-MAIL’s home screen. 
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The utility displays all of the existing Mail.dat files .   
 

 
 
Files can be sorted and viewed by a number of different fields.  These field-specific sort/view options are 

provided in tab format across the top of the display window .  Clicking a specific tab will update the 
job list to display by the that tab’s corresponding field. 
 
In addition, files can be sorted using the filter function by clicking the filter image.  When no filter is 

applied, the filter image appears as an outline (or empty) .    When a filter is applied, the filter image 

will appear solid (or full) .  It is important to note the state of the filter image if a specific job or file 
does not display in the list. 
 

 The filter option is available on most screens containing a jobs list that requires users to 
select jobs from.  It functions the same across all screens.  Click the ‘Watch’ icon for a 
quick demonstration on how to create/use filter profiles.   

Once the available Mail.dat files are displayed in the desired sort order, the user can search for specific 

jobs easily by entering a value specific to the field sort selected .  In the numbered screen image being 
used here (above), the selected sort order is by ‘Job No.’ (i.e. job number); therefore, the user can enter 
text or numbers pertaining to Job Numbers to further narrow their search for a specific job(s).  The 
search begins at the beginning of the field and will not identify jobs with the same search criteria if it 
occurs mid field.  When search criteria is entered, the user must tab out of the field to launch the 
search. 
 
Example 1:  Job Number = 2015_12NL001 
Search Criteria Entered = “2015” (minus the quotation marks) 
Returned Results:  The first job discovered to have a Job Number beginning with “2015” will be 
highlighted. 
 
Example 2:  Job Number = “2015_12NL001” 
Search Criteria Entered = “12NL001” 

https://s3.amazonaws.com/media.windowbook.com/docs/softwareupdates/DM_Filters_Creating_May2018.mp4
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Returned Results:  None found 
 
When a desired job is found, it can be tagged for merging by either clicking in the empty box to the left 
of the job’s line item, or by clicking anywhere on the job’s line item to highlight it and then clicking the 

single red check-mark located at the top of the screen .  A job is tagged when a check-mark displays in 
the box located to the left of the job’s line item.   
 

 
 

 
 
 
 
 
A block of jobs can be tagged simultaneously, such as for mailers 
doing OCI tray-based copal, by using the Special Tag utility.  This 
utility allows users to search for a block of jobs using the First Mailing 
Date, Mail Class, Processing Category, and Release Status fields as 

filters.  To open this utility, click the Special Tag button . 
 
 
 
When all of the filters are set and the Process button is clicked, the post-import process utility identifies 
all of the jobs that meet the set criteria and tags (checks) them automatically for the user. 
Individual jobs can be un-tagged (unchecked) by clicking anywhere on a single job’s line item to highlight 
it and clicking the single red check-mark located at the top of the screen.  The use can also simply click 
on the check-mark located to the left of the specific job’s line item.  If there are multiple jobs tagged and 
the user wishes to un-tag (de-selected) all of them, they can do so all at once by clicking the double-red 

check-mark . 
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HOW TO USE THE POST IMPORT PROCESS UTILITY 

 New Post Process profiles can be created during the use of this utility; however, for 
documentation purposes, the following procedure uses an existing Post Process profile that was 
created through AWAM (refer to the CREATING A POST PROCESS PROFILE section in this Guide). 

To perform a post-import process, do the following: 
 

 This procedure assumes that the AWAM service has already been installed and is running. 

1. From DAT-MAIL’s main or  home screen, click the ‘Utilities’ menu and select ‘AWAM 
Processing’ > ‘AWAM Post-import Process Mail.dat files’; 

2. The Select Mail.dat Files to Post-import process screen will display.  Click the tab 
corresponding to how the available Mail.dat files should be listed (e.g. “by Job No.”); 

3. Select the jobs or files to have post processing applied.  In the example here, two jobs/files 
are selected (i.e. Job Number 00004304 and 00004725);  

 
 

4. Click the Submit to AWAM button (clicking the Cancel button will abort the process and 
close the Select Mail.dat Files to Post-import process screen).  The Select Mail.dat Files to 
Post-import process screen will close and AWAM’s Browse Profiles screen will display.  All 
existing, active Post Process profiles will be listed.   
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At this point, the user has three options:   
 
A. Highlight the Post Process profile to be used and click the Select button (if the profile is 

not active, the button label will read “Activate & Select”); 

 
 

B. Click the Insert button and create a new Post Process profile to use.  Once created, it 

will display in the list and can be highlighted and selected (i.e. Select button); or 

C. Highlight and click an existing Post Process profile and click the Change button to make 

modifications to the existing profile.   

In the example here, the existing profile “Post Process Test” is highlighted and the Select 
button is clicked; 

 For an example of option C above (i.e. Changing an existing profile to be used), refer to step 4 
under the HOW TO USE THE MERGE UTILITY section in this Guide).  Even though the profile type 
being selected is a Merge profile, the procedure is the same for Post Process profiles. 

 
 

 Clicking the ‘Select’ button immediately starts the merge process.  There is no confirmation dialog 

that displays and no way to stop or abort the merge process once the ‘Select’ button is clicked. 
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5. An Info dialog will display. Click the OK button to resolve (close) the 

dialog and continue; 

6. As the merge process begins, AWAM’s Control Center screen displays 
the status of the post-import  process; 

As the post-import process continues, the AWAM’s Control Center screen will update 
accordingly, until the post-import process is complete.  ; 

 

 
 

7. Once the post-import process is complete, click the open folder icon located on DAT-MAIL’s 
main or home screen to view a list of the Mail.dat files or jobs in order to confirm the post-
import process completed successfully based on the profile applied; 

8. The Select Mail.dat File To Open screen will display.  Locate the Mail.dat file(s) selected for 
the post-import process.  In the example here, Job Numbers 00004304 and 00004725 were 
selected and a Post Process profile that used the Run Mass Update function to change the 
permit of a file to “123456” was applied (i.e. Post Process profile “Post Process Test” – refer 
to the CREATING A POST PROCESS PROFILE section in this Guide for more information about 
the creation of this specific profile); 

 
 

Select/highlight one of the jobs (e.g. 00004304) and click the Select button. 
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9. The Advanced Navigator or Navigator screen will display.  Confirm the permit in the MPA 
file has been changed to “123456” as stipulated in the Post Process Test profile; 

 
 
Perform the confirmation for all files selected for post-import processing. 
 

The post-import process is complete. 
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AWAM Processing Log View 

In addition to performing merge processes and post-import processes, the AWAM Processing utility also 
contains an ‘AWAM Processing Log View’ function.   
 

 
 
This ‘View’ displays a list of both the merge and post-import process requests that have occurred by 
date.  In addition, the time the process was run, a description of the process that contains what profile 
was used, and the status of the process is also displayed for each request.   
 

 
 
Users can view additional detail for each log by clicking the View Detail button.  This is sometimes useful 
for troubleshooting purposes. 
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If a process has a status of Failed, the user can determine what caused it to fail and rectify it, at which 
point he or she can select the failed process in the AWAM Log View screen and click the Re-submit 
Failed Task button (button becomes enabled when a Failed task is selected) to successfully apply the 
originally intended process (i.e. either merge or post-import).   
 

 
 

 An example of when a submission can fail is if AWAM goes to process a job that’s locked – in 
other words, that same job has been selected by another person or process in DAT-MAIL for other 
purposes.  AWAM will wait an allotted amount of time for the job to become unlocked (several 
minutes); however, if that time expires with the job still locked, AWAM will time out, the Status 
will display as “Aborted” in the AWAM Control Center, and the submission will be logged as failed 

in the AWAM Log View (see image above for a Failed log). 
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TROUBLESHOOTING 

Unexpected Processing Results 

If a job fails processing or shows as completed, but the end result of the imported, merged, or post-
import processed file is not as expected, users can view the various logs generated during processing to 
try and identify any anomalies or errors that may have occurred.   
 
To view the log files that were generated once processing has completed, right click on the job’s line 
item in the AWAM Control Center – either in the Activity tab or the History tab.  If a log file is grayed 
out, it has not been created (i.e. does not exist) for the selected job. 
 

 
 
Select the log file to open.  A Windows® Notepad window will launch and the contents of the selected 
log file will display  Events of the processing are reported in chronological order (oldest to newest).   
 
The available log files are: 

• AWAM Trace Log:  The AWAM Trace Log provides a quick list of steps that were taken while 
processing.  Errors will be reported as they occurred until the process aborted; 

 Depending on what the profile has been set up to do, the trace log for a processed job can be 
quite large/long. 

• AWAM Debug Log:  The AWAM Debug Log provides internal debugging information that occurs 
in certain procedures.  This is a useful log to have when having to dig into problems; 

• Daemon Error Log:  The Daemon Error Log reports the errors that would typically display in pop-
up message windows when running procedures manually from within DAT-MAIL.  Because the 
error message windows cannot be allowed to display when these same procedures are run from 
a service (i.e. AWAM), Window Book redirects them to this output log so they can be referred to 
later if necessary.  This log sometimes captures errors that currently do not always get into the 
Debug or Trace Log files; and 
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• CMD Files:  At this time (November 2017), CMD files are specific to post-processing requests (i.e. 
Merge and Post-Import Processing).  They contain the parameters with wich the post-processing 
will use to run, and include the profile ID and JobID information so AWAM knows what jobs to 
apply the specified profile to. 

 These Log files are an important tool; therefore, if requesting troubleshooting assistance from 
Window Book’s Technical Support team, Window Book strongly recommends including any 
available Log files for the job in question. 

 

The Setup Menu Does Not Display 

In a server with workstation(s) environment, if no ‘Setup’ menu option displays in the AWAM Control 
Center’s ‘File’ menu, determine whether or not the Control Center is being operated on a server or a 
workstation. 
 

 
 
 
AWAM On Workstations:  The ‘Setup’ menu option is not available on workstation installations of 
AWAM.  There is no problem. 
 
AWAM On Servers (or computers in single installation environments):  If the ‘Setup’ menu option is 
not available in the AWAM Control Center that is running on a server (or computer in a single 
installation environment), perform the following: 
 

1. Close/exit AWAM and launch DAT-MAIL; 

2. From DAT-MAIL’s home screen, select ‘File’ > ‘Program Settings’ > ‘Program Setup’.  The 
‘Setup’ screen will display; 
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3. In the ‘Import Defaults’ tab, enter the name of the server or computer AWAM is being run 
on in the “AWAM Server Name” field.   Click the OK button when finished; 

 
 

4. Launch AWAM.  The ‘Setup’ menu will now be displayed/accessible. 
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APPENDIX 1 – EXAMPLE PROFILES 

This section of the Guide is to provide examples of how to create specific profiles commonly used by 
mailers.  Examples are separated by profile type (i.e. Import, Merge, and Post Process). 
 

 The information provided in this Appendix assumes that AWAM is already activated, registered, 
and setup on the server. 

EXAMPLE IMPORT PROFILES 

Statement Generation With Spoilage 

To create an import profile to generate statements with spoilage, perform the following: 
 

1. Launch DAT-MAIL and navigate to ‘File’ > ‘Program Settings’ > ‘Program Setup’; 

2. The DAT-MAIL Setup screen will display.  Select (click) the ‘Statement Generation’ tab.  
Select (check) the ‘Check for pending spoilage at statement generate time’ option, which 
will enable DAT-MAIL to make the appropriate adjustments to a Mail.dat file for spoilage 
prior to generating a statement; 

 If the DAT-MAIL Spoilage Module is installed, this option will automatically be selected (checked).  
The option will also be grayed out so the user cannot voluntarily enabled or disable this option.  If 
the Spoilage Module is not installed, the user can select and deselect this option as needed. 
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3. Launch AWAM.  Create a new AWAM Import profile as instructed in CREATING & USING AN 
IMPORT PROFILE (i.e. name the new import profile (e.g. “Spoilage & Statements”), and 
specify the various folders/paths for it to use (i.e. Source, Processed, and Failed)); 

 In a server with workstation(s) environment, UNC names must be used for the folder paths. 

4. Select the ‘Post Processing’ tab.   Select (check) the ‘Generate Statements Automatically’ 
option.  Click the Statement Setup button; 

 
 

5. The New Statement Information screen will display.  Set up the appropriate options, and 
generate the desired statement; 
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6. The screen will close and the profile’s Post Process screen will display.  Select (check) the 
‘Run Batch Reports’ option.  Click the Batch Reports Setup button; 

 
 
 

7. The Batch Report Profiles… screen will display.  Click the Insert button if the desired Batch 
Report Profile is not displayed (if the desired Batch Report Profile is displayed, highlight the 
Report Profile and click the Select button); 
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8. The Batch Report Selection screen will display.  Enter a name for the new batch report 
Profile and tag (check) all of the report that are to be printed (in the example here, the 
‘Spoilage Detail Report’).  Setup any other available options that should be used in the 
report (e.g. ‘Generate PDF’).  Click the OK button when finished; 

 
 

9. The Batch Report Profiles… screen will display.  Highlight the newly created Report Profile 
and click the Select button; 
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10. The Batch Report Profiles… screen will close and the import profile’s updated Post 
Processing screen will display; 

 
 

11. Click the OK button to save and close the import profile.  Make sure to activate the profile 
for use (refer to Activating & Deactivating Profiles for more information).  Appropriate 
Mail.dat files can now be dropped into the specified “source” or hot folder (refer to step 3 
above) and AWAM will complete the import process.  After an import is complete, open an 
imported file in DAT-MAIL to verify spoilage has been applied. 

Release Only With Spoilage 

To create an import profile to only create release files with spoilage, perform the following: 
 

1. Launch DAT-MAIL and select ‘File’ > ‘Program Settings’ > ‘Program Setup’; 

2. The Setup screen will display.  Select the ‘PostalOne!’ tab; 
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3. Select (click) the Only Create Release Files button.  When this button is checked, the default 
‘Generate Statements’ option will be disabled.  Click the OK button to close the Setup 
screen; 

 
 
 

4. Launch AWAM.  Create a new AWAM Import profile as instructed in CREATING & USING AN 
IMPORT PROFILE (i.e. name the new import profile (e.g. “Spoilage & Release Only”), and 
specify the various folders/paths for it to use (i.e. Source, Processed, and Failed)); 

 In a server with workstation(s) environment, UNC names must be used for the folder paths. 

5. Select the ‘Post Processing’ tab.   Select (check) the ‘Only Create Release Files’ option; 
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6. Select (check) the ‘Release Mail Automatically’ option and click the Release Mail Setup 
button; 

 
 

7. The Process PostalOne Release screen will display.  Use the scheduled dates that are in the 
Mail.dat file (default option) or enter/select a Ship Date.  Click the OK button when finished 
to close the screen; 

 
 

8. If preferred, select or set other options such as Run Batch Reports (refer to Statement 
Generation With Spoilage for instructions on how to set up the Run Batch Reports option).  
Click the OK button when finished to save and close the import profile; 
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9. Make sure to activate the profile for use (refer to Activating & Deactivating Profiles for more 
information).  Appropriate Mail.dat files can now be dropped into the specified “source” or 
hot folder (refer to step 4 above) and AWAM will complete the import process.  Once a file 
has been imported, DAT-MAIL will generate an original release, then check for pending 
spoilage and create an updated release.  The updated release will account for any spoilage 
within the file and make the proper adjustments. 

Auto Importing QuickFix Files 

If corrections/edits are made to a Mail.dat file using eDM10X’s QuickFix feature, the corrected file must 
be imported back into DAT-MAIL in order to incorporate the corrected information into the original 
Mail.dat.  Depending upon your needs, automatically importing Mail.dat files back into AWAM can be 
set up one of two ways:  Using the default AWAM import profile, or creating/using an import profile 
specific to QuickFix files. 
 

 QuickFixed Mail.dat files are generated only when the submitted file has been accepted by 
PostalOne!  If a Mail.dat file is QuickFixed and submitted to PostalOne! and that submission fails, 
a ‘fixed’ Mail.dat file will not be generated. 

 These procedures assume MailDrop Engine is installed and being used. 

 

USING THE DEFAULT AWAM IMPORT PROFILE 

To use AWAM default import profile to auto-import the QuickFixed Mail.dat files back into DAT-MAIL, 
perform the following: 
 

1. On the server, open DAT-MAIL and launch AWAM.  In the AWAM Control Center, click the 
Edit profiles button; 

2. The Browse Profiles screen will display.  Identify the default import profile; specifically, the 
default import folder specified in the profile (in the example being used here, the 
‘\\...\wb\mail.dat\incoming’ folder is set as the default import folder).  Make sure the 
default import profile is active; 
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3. On the server, open MailDrop Engine (MDE).  On the Home screen, using the corresponding 
Browse… button, select the same import folder used with AWAM’s default import profile as 
the ‘DAT-MAIL Mail.dat Import folder for QuickFix edited files’ option.  Stop and restart the 
service; 

 
 

 In a server with workstation(s) environment, make sure a UNC name is used for the QuickFix 
folder. 

4. Within DAT-MAIL, navigate to ‘File’ > ‘Program Settings’ > ‘Program Setup’; 

5. The Setup screen will display.  In the ‘Import Defaults’ tab, click the QuickFix File Path 
button.  Navigate to, and select the same path/folder selected in MDE for the QuickFix File 
Path to be used by DAT-MAIL (e.g. \\...\wb\mail.dat\incorming’).  Click the OK button to 
close the Setup screen, saving the update; 
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 In a server with workstation(s) environment, make sure a UNC name is used for the QuickFix 

folder. 

USING AN IMPORT PROFILE SPECIFIC TO QUICKFIX FILES 

QuickFixed Mail.dats can be automatically imported back into DAT-MAIL by creating and using a 
QuickFix-specific AWAM import profile.  To do this, perform the following: 
 

1. On the server, open DAT-MAIL and launch AWAM.  In the AWAM Control Center, click the 
Edit profiles button; 

2. The Browse Profiles screen will display.  Click the Insert button and select the ‘New Import 
Profile’ option; 

3. A Profile Will Be Added screen will display.  Name the new QuickFix import profile (e.g. 
“Auto Import QuickFix Files”).  Using the corresponding browse button for the ‘Source Path’ 
field, navigate to and create and/or select a folder to be used specifically for Mail.dat files 
that have been corrected using QuickFix (e.g. ‘\\...\wb\mail.dat\QF_Edits’).  Click the OK 
button when finished; 

 
 

 In a server with workstation(s) environment, make sure a UNC name is used for the QuickFix 
folder. 

4. The Browse Profiles screen will display.  Select/highlight the newly created QuickFix import 
profile and click the Activate button (when the profile becomes active, the button label will 
change to display “Deactivate”).  Click the Close button when finished; 

 



AWAM™ 

User Guide  Appendix 1 – Example Profiles 

©2018 Window Book, Inc.  All Rights Reserved.  Page 99 of 105 

 
5. Repeat steps 3 through 5 documented under USING THE DEFAULT AWAM IMPORT PROFILE, 

substituting the default import folder with the newly created folder used in the QuickFix-
specific import profile (i.e. ‘\\...\wb\mail.dat\QF_Edits’). 

 In a server with workstation(s) environment, make sure a UNC name is used for the QuickFix 
folder. 

Turn Off Logging Barcodes  

The following is an example of an import profile that turns off logging the barcodes in our IMBM 
database.  It assumes the following global settings have been applied in DAT-MAIL’s Setup screen (see 
image below). 
 

 
 

 This profile has its’ own, dedicated import folder. 

To create an import profile that turns off logging the barcodes in our IMBM database, perform the 
following: 
 

1. On the server, open DAT-MAIL and launch AWAM.  In the AWAM Control Center, click the 
Edit profiles button; 

2. The Browse Profiles screen will display.  Click the Insert button and select the ‘New Import 
Profile’ option; 
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3. A Profile Will Be Added screen will display.  Name the new import profile (e.g. “Turn Off 
Logging Barcodes”).  Using the corresponding browse button for the ‘Source Path’ field, 
navigate to and create and/or select a folder to be used specifically for Mail.dat files where 
the barcodes should not be logged (e.g. ‘\\...\wb\mail.dat\AWAM_TurnOffBarcodes’).  Click 
the OK button when finished; 

 
 

 In a server with workstation(s) environment, make sure a UNC name is used for the source folder. 

4. Select (click) the ‘Post Processing’ tab.  Within the Post Processing tab, select (click) the 
‘Intelligent Mail Barcode’ tab.  Enable (check) the ‘Override Global Barcode Assignment 
Settings’ option.  Then, enabled (check) the ‘Overwrite Pallet Label 24 Char barcodes’ and 
the ‘Overwrite Tray/Sack Label 24 Char barcodes’ options.  Click the OK button when 
finished; 
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5. The Browse Profiles screen will display.  Select/highlight the newly created ‘Turn Off Logging 
Barcodes’ import profile and click the Activate button (when the profile becomes active, the 
button label will change to display “Deactivate”).  Click the Close button when finished. 

 

Log Barcodes Without Overwriting Them 

The following is an example of an import profile that logs barcodes without overwriting them.  It 
assumes the following global settings have been applied in DAT-MAIL’s Setup screen (see image below). 
 

 
 

 This profile has its’ own, dedicated import folder. 

To create an import profile that logs barcodes without overwriting them, perform the following: 
 

1. On the server, open DAT-MAIL and launch AWAM.  In the AWAM Control Center, click the 
Edit profiles button; 
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2. The Browse Profiles screen will display.  Click the Insert button and select the ‘New Import 
Profile’ option; 

3. A Profile Will Be Added screen will display.  Name the new import profile (e.g. “Log Barcodes 
Only”).  Using the corresponding browse button for the ‘Source Path’ field, navigate to and 
create and/or select a folder to be used specifically for Mail.dat files where the barcodes 
should not be logged (e.g. ‘\\...\wb\mail.dat\AWAM_LogBarcodesOnly’).  Click the OK 
button when finished; 

 
 

 In a server with workstation(s) environment, make sure a UNC name is used for the source folder. 

4. Select (click) the ‘Post Processing’ tab.  Within the Post Processing tab, select (click) the 
‘Intelligent Mail Barcode’ tab.  Enable (check) the ‘Override Global Barcode Assignment 
Settings’ option.  Click the OK button when finished; 
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5. The Browse Profiles screen will display.  Select/highlight the newly created ‘Log Barcodes 
Only’ import profile and click the Activate button (when the profile becomes active, the 
button label will change to display “Deactivate”).  Click the Close button when finished. 

 

Turn On Overwrite for Trays/Pallets, Generate/Replace 

Barcodes   

The following is an example of an import profile that turns on the overwrite for trays/pallets so barcodes 
are generated and replace what is currently in the CSM file.  It assumes the following global settings 
have been applied in DAT-MAIL’s Setup screen (see image below). 
 

 
 

 This profile has its’ own, dedicated import folder. 
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To create an import profile that turns on the overwrite for trays/pallets so barcodes are generated and 
replace what is currently in the CSM file, perform the following: 
 

1. On the server, open DAT-MAIL and launch AWAM.  In the AWAM Control Center, click the 
Edit profiles button; 

2. The Browse Profiles screen will display.  Click the Insert button and select the ‘New Import 
Profile’ option; 

3. A Profile Will Be Added screen will display.  Name the new import profile (e.g. 
“Overwrite/Generate/Replace Barcodes”).  Using the corresponding browse button for the 
‘Source Path’ field, navigate to and create and/or select a folder to be used specifically for 
Mail.dat files where the barcodes should not be logged (e.g. 
‘\\...\wb\mail.dat\AWAM_OverwriteGenReplaceBarcodes’).  Click the OK button when 
finished; 

 
 

 In a server with workstation(s) environment, make sure a UNC name is used for the source folder. 

4. Select (click) the ‘Post Processing’ tab.  Within the Post Processing tab, select (click) the 
‘Intelligent Mail Barcode’ tab.  Enable (check) the ‘Override Global Barcode Assignment 
Settings’ option and then enable (check) the ‘Do not register IM Barcodes’ option.  Click the 
OK button when finished; 
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5. The Browse Profiles screen will display.  Select/highlight the newly created ‘Log Barcodes 
Only’ import profile and click the Activate button (when the profile becomes active, the 
button label will change to display “Deactivate”).  Click the Close button when finished. 

 
 
 

EXAMPLE MERGE PROFILES 

No examples available at this time. 

EXAMPLE POST PROCESS PROFILES 

No examples available at this time. 
 
 


